
As we usher in the new year, I want to take a moment to wish each of you a

healthy, happy, and successful 2025. May this year bring new opportunities

for growth, fulfillment, and joy in all that you do.

Let’s enter this new chapter with optimism, strength, and the determination

to make the most of every moment. Together, let's continue to support and

inspire one another as we create a future filled with possibilities.

In the near future, you can expect some exciting changes to our program,

which will bring new and expanded services to better support our families.

We are eager to share these developments with you, pending the approval

of our proposed plan amendments. These changes will help ensure that we

are meeting the evolving needs of our community and providing even more

valuable services and resources.

We would also like to extend our deepest gratitude to the Shingle Springs

Band of Miwok Indians for their continued support and understanding of

the ever-changing needs within our Native community.

Their dedication to establishing resilient, accessible services for families on

their journey to self-sufficiency is truly appreciated.

Thank you for being an active part of this program. We encourage you to

take full advantage of the resources and services available to assist your

family, and we look forward to continuing this journey with you.

Daniel Delgado

February 2025
Newsletter

In this newsletter
you can expect:

TANF Site Updates

 Transportation 

Advice

 Education Updates
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Hoht-so, Ya’ah’teeh, Mun’ahoo, and Michuksus

from Yolo.

Now that we are in full swing of 2025. We hope

that the new year brings abundance to you and

your family. Children are back in school and this

marks the half way time with Spring right around

the corner. 

Here are a few awareness campaigns for the

month of February. The Go Red For Women

movement works to save women’s lives and beat

heart disease, the number one killer of women.

On National Wear Red Day, support the

movement by wearing red on February 7th.

Another one is Teen Dating Violence month.

According to Love is Respect. 1 in 3 U.S. teens

will experience physical, sexual, or emotional

abuse from someone they’re in a relationship

with before becoming adults. And nearly half

(43%) of U.S. college women report

experiencing violent or abusive dating behaviors. 

Our upcoming events: Youth Beading, February

3, 2025, from 5:00pm to 7:00pm, Family Beading

will be on February 28th, 2025, from 5:00pm to

7:30pm. Also, Abalone Heart Wreath night will

be held on February 26th, 2025, from 5:00pm to

7:00pm. 

Please RSVP with Ronda and come have some

fun. As a friendly reminder, your MER is due by

the 10th of each month. As always, our staff is

here to be of service, so email, stop by or call us

at 916-741-5056.

Ah-ho (thank you) Ronda, Sapphira, Raymond

and Mary.

Yolo Site
Hello and Happy February!

We hope that you are having a good new year so far.

For February, here are some community activities at

your local El Dorado County library for you and

your family to enjoy! At the Placerville library:

Toddler activities: Play and Learn, Early Literacy

Storytime, Mother Goose on the Loose, US Forest

Service -Read with a Ranger, Lego Block Party, and

Skywatching Family Evening. At the Cameron Park

library: Saturday Arts, Crafts and Educational

Activities, Play and Learn, Crawl Space, Early

Literacy Story Time, Mother Goose on the Loose,

Build ‘n Play, and Afterschool Adventures. At the

Georgetown Library: Early Literacy Story Time and

Mother Goose on the Loose. At Pollock Pines

Library: Literacy Dog, Early Literacy Play and Lego

Play Time.

Don’t forget to ask about the various kits at your

local library! Storytime Kit: Each themed kit

includes materials that help foster a love of reading

while supporting early literacy skills in a home or

preschool setting. The Toddler Storytime Kits are

geared for 0–3-year-olds, all other Storytime Kits are

geared for 4–7-year-olds. Only available at the

Cameron Park Library, El Dorado Hills Library,

Georgetown Library, and Placerville Library.

Check out a FREE California State Library Parks

Pass with your El Dorado County Library card! . 

The California State Library Parks Pass program

allows patrons to check out a free California State

Parks day use pass.

Other than that, please make sure to RSVP for our

monthly El Dorado Site Family Culture Night! We

can’t wait to see you and your family! 

Feel free to contact us anytime 530-683-0110! 

-Dani, Julia, and Stephanie 

El Dorado Site



Séekas’in! 

Happy February 2025 TANF Family – Placer is

the place to be! 

Our Placer County Community is full of fun and

activities to enjoy! This month please take your

time to enjoy the Maidu Museum in Roseville

from 9am-4pm, enjoy the Maidu Regional Park to

play indoor soccer, basketball, use the outdoor

fitness court, or play on the lighted softball

complex. Feel free to go on a walking trail or

enjoy the First People’s Village & Native Garden

at the Placer Nature Center.  Join the Redbud

Chapter of California Native Plant Society, or

enjoy one of the various Storytimes, Toddler

Times & Baby Lapsits at your local library! There

is a scheduled Used Book Sale on 2/8/2025 at the

Downtown Library in Roseville. Go to your local

library and sign up to be a Roseville Ranger! With

your Adventure Pack you can explore your local

parks or discover hidden natural worlds in your

backyards! 😊 Don’t forget to ask for a Storytime

Kit before you leave your library! Each kit

includes a variety of books, props, and activities

about a theme that you can pick out yourself! 

Lastly, don’t forget to bring your swimsuit when

you go to the very special Parent & Tot Storytime:

Reading with a Mermaid on 2.06.2025 from 10-

11:20am at the Mike Shellito Indoor Pool! 

Other than that, please make sure to RSVP for

our monthly Placer Site Family Culture Night! We

can’t wait to have dinner with you and your

family!

Feel free to contact us anytime! Happy February! 

Jenna Becker, SM, 530.820.0145

Noel Edmondson, FA, 530.820.0148

Welcome 2025 – Exciting New Year Ahead!

Dear Families,

We hope you all had a wonderful holiday season and

a joyful start to the new year! As we return to the

office and dive into 2025, we are excited about all that

lies ahead. Our team has been busy planning a variety

of events, workshops, and classes across all of our

departments, and we can’t wait to share these

opportunities with you throughout the year.

Whether you're looking to learn something new,

improve a skill, or simply connect with others in our

community, there will be something for everyone.

Please make sure to stay engaged and take advantage

of these valuable resources.

As always, we encourage you to continue reaching out

to your Family Advocate for support, guidance, or

any questions you may have. We're here to help, and

we look forward to working together to make this

year a success.

See you soon at our upcoming events!

Warm regards,

 Sacramento TANF Staff
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Greetings TANF Families!

Prevention Staff are looking forward to

training in Portland, 2/10/25-2/14/25:

Adults Working with Native Youth. This will

expand the variety of events we can offer to

youth.

Spring is coming soon, and we will be busy

preparing for the Spring Gathering in March.

We invite you to attend the events listed on

the monthly calendar. TANF may be able to

assist with transportation, but please contact

your Family Advocate a week in advance for

transportation requests. Call if you have

questions.

Sincerely,

The TANF Prevention Team

Rosemary, Nikki, Ancita, Stephanie, Pauline,

Richard, and Erikka
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Prevention Update

Beading Circle 12/2/24

Beading Circle 12/2/24

Winter Solstice 12/13/24

Beading Circle 12/2/24

Winter Solstice 12/13/24

Winter Solstice  12/13/24

Winter Solstice 12/13/24

Winter Solstice 12/13/24



Acclaimed author Ruby

Slipperjack delivers a haunting

novel about a 12-year-old girl’s

experience at a residential school

in 1966.

 An empowering picture book

about family history, self-

expression, and reclaiming your

identity. Our ancestors say our

hair is our memories, our source

of strength and power.

Published out of St. Joseph's Mission at

Williams Lake, BC, Sellars tells of three

generations of women who attended

the school, interweaving the personal

histories of her grandmother and her

mother with her own. 

Feb. 3rd   

5-7pm

Family Beading

Part 1

YOLO

Feb. 4th   

5-7pm

Abalone Heart

Wreath
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Books of the  Month

February Classes

Education and Employment 

Open Lab 

9:30-11:30am

Feb. 6th - Placer Site

Feb. 13th - El Dorado Site

Feb. 20th - Yolo Site

Feb. 27th - Sacramento Site

Feb. 5th   

5-7pm

Wellness Warriors

Feb. 6th   

5-7pm

Water is Life

Feb. 7th   

10:30am-2pm

Open Beading

Feb. 11th   

10am-1pm

Digital Literacy

Feb. 12th   

10am-12pm

Career Compass

Feb. 13th   

10am-1pm

Community Resource

Group

PLACER

Feb. 18th   

10am-12pm

YEOP Workshop

Feb. 18th   

4pm-6pm

Flute Lessons

Feb. 18th   

5pm-7pm

Beading Circle

Feb. 19th   

10am-12pm

Career Compass

Feb. 19th   

4pm-6pm

Flute Lessons

Feb. 20th   

5-7pm

Abalone Heart

Wreath

PLACER

Feb. 21st

5pm-7pm

Young Men’s Drum

Group

Feb. 21st

5pm-7pm

Daughters of Tradition

Feb. 24th   

5pm-7pm

Medicine Wheel

Feb. 25th   

4pm-6pm

Abalone Heart

Wreath

EL DORADO

Feb. 26th

5pm-7pm

Abalone Heart Wreath

YOLO

Feb. 26th

10am-12pm

Career Compass

Feb. 27th   

4pm-6pm

Little Feathers

Feb. 28th

5pm

Participation Raffle

Feb. 28th

5pm-7pm

Family Beading

 Part 2

YOLO

Feb. 11th   

10am-12pm

Financial Literacy



Getting to Know Microsoft Word: Styles, Themes, and Tables

Microsoft Word is a versatile word processing tool that helps users create professional

documents with ease. Two key features that enhance the appearance and organization of your

documents are Themes, and the ability to insert tables. Here’s how you can make the most of

these features.

Themes provide a coordinated set of fonts, colors, and effects that you can apply to your entire

document. Here’s how to use them:

Applying a Theme: Go to the Design tab. In the Themes group, click on Themes and choose

from the available options. The theme will apply to your whole document, ensuring a cohesive

look.

Customizing a Theme: You can customize the colors, fonts, and effects by selecting the

respective options in the Design tab. Save your custom theme for future use by clicking on

Themes and selecting Save Current Theme.

Inserting a Table

Tables are a great way to organize data in your document. Here’s how to insert and format a

table:

Inserting a Table: Place your cursor where you want the table. Go to the Insert tab, click on

Table, and drag to select the number of rows and columns you need. Alternatively, you can

choose Insert Table and specify the dimensions.

Formatting a Table: Once inserted, use the Table Tools Design and Layout tabs to format your

table. You can apply table styles, adjust cell sizes, and add borders and shading.

Adding and Deleting Rows/Columns: Right-click in a cell, then choose Insert or Delete from

the context menu to add or remove rows and columns as needed.

By mastering Styles, Themes, and Tables, you can create well-organized and visually appealing

documents in Microsoft Word. These features not only enhance the look of your documents but

also improve their readability and professionalism.

Bold Ctrl+B

Italic Ctrl+I

Underline Ctrl+U
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Microsoft Keyboard Shortcuts (These are used by most of Microsoft Applications)

Italicizes the selected text.

Makes the selected text bold.

Underlines the selected text.



INGREDIENTS:

¾ pound lean ground turkey

1 large onion, peeled and chopped

1 medium green bell pepper, seeded and chopped

1 (14½-ounce) can no-salt-added diced tomatoes

1 cup low-sodium canned black beans, drained and rinsed

½ cup prepared barbecue sauce

1 teaspoon garlic powder

1 teaspoon liquid smoke

3 bell peppers (any color)​
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PREPARATION:

Brown ground turkey in a medium skillet over medium-high heat until no longer pink;

drain excess fat.

1.

Add onion and cook until tender, about 5 minutes.2.

Add all remaining ingredients except the whole bell peppers; simmer for 10 minutes

over medium heat.

3.

Meanwhile, cut the whole bell peppers in half lengthwise and remove the seeds. Place in

a microwave safe dish with a small amount of water.

4.

Cover and microwave bell peppers on high until crisp-tender, for about 5 minutes.5.

Remove peppers from the dish and place on a large plate. Spoon turkey mixture into

bell pepper shells and serve.

6.

BBQ Turkey in Pepper Shells

Our top 10 driving tips for 2025:

 Buckle Up Every Trip, Every Time: Always wear your seat belt correctly to reduce injury risk in a

crash.

1.

 Ensure Children Are in the Right Seat: Use the appropriate car seat for your child's age and size,

and ensure it's installed correctly.

2.

Drive Sober: Never drive under the influence of alcohol or drugs. Plan a safe ride home if needed.3.

Pay Attention to the Road: Avoid distractions like texting, eating, or adjusting the stereo while

driving.

4.

Obey Speed Limits: Follow speed limits and adjust your speed for road conditions.5.

 Never Drive Drowsy: Ensure you get enough sleep and be aware of how medications may affect

your driving.

6.

Share the Road Responsibly: Be mindful of other motorists, motorcyclists, bicyclists, and

pedestrians.

7.

Check for Recalls: Regularly check for vehicle recalls and ensure necessary repairs are made.8.

Pay Attention to Flashing Lights: Move over or slow down for vehicles with flashing lights and

follow school bus laws.

9.

Talk to Teen Drivers: Encourage safe driving habits in teens, including wearing seat belts and

avoiding distractions.

10.

This dish is colorful and healthy. You can save money by using all 

green bell peppers.



8

Start by updating your resume and LinkedIn profile to reflect your latest skills and experiences. 1.

Set clear, actionable career goals and invest in skill development through courses or workshops. 2.

Expand your professional network by attending industry events and connecting with colleagues

online. 

3.

Brush up on interview skills, practice answering common questions, and tailor your applications to

each job. 

4.

Embrace flexibility by considering remote or freelance work, and prioritize positions that offer a

healthy work-life balance. 

5.

Stay organized with an application tracker, follow up after interviews, and maintain a positive

attitude throughout the job search. 

6.

Persistence is key—refine your approach and keep going until you find the right opportunity. 7.

Please feel free to call the employment department for help with any of these steps.

Employment Department

Kick off your career in 2025 with these key employment tips! 
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Sacramento Site
2033 Howe Ave. Suite 100

Sacramento, CA 95825
916-760-1660

El Dorado Site
532 Main St.

Placerville, CA 95667
530-683-0110

Placer Site 
1919 Grass Valley Hwy. Suite 110 

Auburn, CA 95603
530-820-0141

Yolo Site
1355 Halyard Dr. Suite 180

West Sacramento, CA 95691
916-741-5056

Navigating the financial aid process is complicated for everyone, but it can be especially confusing for

first-generation applicants. A study from the Pew Research Center reports that first-generation

students are more likely to incur college debt, and more of it.

Applicants should fill out the FAFSA, typically due at the end of June for each academic year, which is

responsible for a large portion of many applicants' financial aid package.

Some universities also allow students to submit financial aid appeals. If students feel they did not

receive enough in scholarships, grants or loans in a university’s offer, they may be able to appeal to

increase their aid package. Hauad stresses the importance of asking questions throughout the entire

process.

“You need things, and you should ask for them, even if the outcome is not what you want, you should

ask,” Hauad says. “That’s a big piece in any part of the process. You need to be proactive.”

First-generation students can also look for scholarships and aid that cover living expenses in addition

to tuition and fees, as well as scholarships offered exclusively to first-gen students. 

Elliott advises students to budget based on the financial breakdown given to them by their college, and

then seek out and account for any hidden costs and fees.

“This can be asking your academic adviser if there are certain courses that have course fees. Those are

often huge surprises that come up and can be $300 to $400, depending on what your major is,” she

says.

Alongside academic advisers, current students of the same intended major can be a good resource for

uncovering potentially hidden costs.

Elliott also recommends looking for on-campus resources such as food pantries, textbook banks and

school-sponsored transportation, which can help bring down the cost of living.

Financing Your Higher Education

Education Department

https://www.usnews.com/education/best-colleges/paying-for-college/articles/an-ultimate-guide-to-understanding-college-financial-aid
https://www.pewresearch.org/social-trends/2021/05/18/first-generation-college-graduates-lag-behind-their-peers-on-key-economic-outcomes/
https://www.usnews.com/education/best-colleges/paying-for-college/articles/completing-the-fafsa
https://www.usnews.com/education/best-colleges/paying-for-college/articles/strategies-for-appealing-a-college-financial-aid-package
https://www.usnews.com/education/best-colleges/paying-for-college/articles/college-fees-that-may-surprise-you
https://www.usnews.com/education/articles/how-colleges-are-addressing-food-insecurity




Tuesday Wednesday Thursday

Sacramento Site
2033 Howe Ave. Suite 120

Sacramento, CA 95825
916-760-1660

El Dorado Site
532 Main St.

Placerville, CA 95667
530-683-0110

Yolo Site
1355 Haylard Dr. Suite 180

West Sacramento, CA 95691
916-741-5056

Placer Site 
1919 Grass Valley Hwy. Suite 110 

Auburn, CA 95603
530-820-0141

20 21 22

MondaySunday Friday Saturday

TANF Website

February 2025
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Education and Employment 

Open Lab 

9:30-11:30am

2/06 Placer

2/13 El Dorado

2/20 Yolo

2/27 Sacramento

Abalone Heart

Wreath

5pm-7pm

26 27 28

Young Men’s Drum Group

5pm-7pm

Little Feathers

4-6pm

Beading Circle

5-7pm

Participation Raffle

5pm

Family Beading

YOLO

5-7pm

Family Beading

YOLO

5-7pm

Abalone Heart

Wreath

PLACER

5pm-7pm

Abalone Heart

Wreath

EL DORADO

4pm-6pm

Abalone Heart Wreath

YOLO

5pm-7pm

Wellness Warriors

5pm-7pm

Water is Life

5pm-7pm

Open Beading

10:30am-2pm

Flute Lessons

4pm-6pm

Flute Lessons

4pm-6pm

Daughters of Tradition

5pm-7pm

Medicine Wheel

5-7pm

Digital Literacy

10am-1pm

Career Compass

10am-12pm

Career Compass

10am-12pm

Career Compass

10am-12pm

YEOP Workshop

10am-12pm

Financial Literacy

10am-12pm

MERS DUE





CAREER COMPASS:
CHART YOUR PATH TO SUCCESS

Join us for a workshop series that guides you through every
step of job obtainment. Explore your strengths with career
assessments, craft tailored resumes and cover letters, and

sharpen your interview skills. Whether starting or advancing,
this series equips you to confidently navigate your career

path.

Transportation available upon request.
 INCENTIVES WILL BE provided to eligible

participants who attend.

P L E A S E  R S V P :
C A Y C E  B O R G E S ,  E M P L O Y M E N T  C O O R D I N A T O R

C B O R G E S @ S S T A N F . O R G
 ( 9 1 6 )  7 6 0 - 1 6 6 3

D A T E S :  2 / 1 2 ,  2 / 1 9 ,  2 / 2 6
S I T E :  S a c r a m e n t o  S i t e  o r  V i r t u a l

T I M E :  1 0 a m - 1 2 p m
A t t e n d e e s :  A d u l t s  ( 1 8  a n d  u p )

Z O O M  O P T I O N  A V A I L A B L E  
M E E T I N G  I D :  8 1 1 - 5 3 9 8 - 6 9 4 7

P A S S C O D E :  T A N F 2 0 2 5

IN-PERS ON  W ORKSHOP :
S ACRAMENTO  S ITE

2033  HOW E  AVE . ,  SU IT E  200
SACRAMENTO ,  CA  95825

FEB
3RD &
28TH

M O N
&

F R I

5 : 0 0 P M -
7 : 0 0 P M

S H I N G L E  S P R I N G S  T R I B A L  T A N F

Y O L O  S I T E
1 3 5 5  H A L Y A R D  R D

S T E  1 8 0
W E S T  S A C T A M E N T O ,  C A  

9 5 6 9 1

FamilyBeading

enrolled member of
The Klamath Tribes

 P A R T I C I P A N T S  O N L Y  |  T R A N S P O R T A T I O N  A V A I L A B L E

Join us for this Youth
Beading event with

Chandra Cortez making
beaded moccasins!

To RSVP Contact:
Pauline Ghost,

Youth Activity Specialist
916-798-9433

DEBT CONSOLIDATION
WORKSHOP 

Come and learn about the
importance of credit and debt. 

DATE AND TIME
Wednesday, February 5th 

from 10am-12pm

P le a s e  R S V P :
C a y c e  B o r g e s ,  

E mp l o y m e n t  C o o r d in a t o r
c b o r g e s @ s s t a n f . o r g
( 9 1 6 )  7 6 0 - 1 6 6 3

PLACER SITE
1919 GRASS VALLEY HWY. ,  STE 110
AUBURN,  CA 95603

OR VIA  ZOOM
MEETING ID:  892 6008 7736
PASSCODE:  TANF2024

Transpor tat ion ava i lab le  upon  reques t

S H I N G L E  S P R I N G S  T R I B A L  T A N F
P R O G R A M

Join us for Family Culture Night 

 Abalone Heart
Wreaths

Let’s make abalone heart wreaths. In many Native American
cultures, particularly along the Pacific coast, the abalone shell holds
deep spiritual significance, often associated with the ocean's power,
protection, and healing abilities; with some tribes believing the shell

represents the first woman or a connection to the spirit world

Sacramento Site
February 4, 2025

5pm-7pm

Placer Site
February 20, 2025

5pm-7pm

Yolo Site
February 26, 2025

5pm-7pm

El. Dor Site
February 25, 2025

4pm-6pm

To RSVP Contact:
Stephanie Dominguez

Youth Activity Specialist
Sduarte@sstanf.org or 

916-760-1679



SHINGLE SPRINGS TRIBAL TANF 

WELLNESS
WARRIORS

JOIN US ON A HEALTHY JOURNEY
ENCOURAGING FAMILY FORMATION          

AND WELLNESS 
February 5, 5-7 pm

Sacramento Site

   RSVP WITH RICHARD SANCHEZ
916-673-8661 or  rsanchez@sstanf.org

TANF PARTICIPANTS ONLY
TRANSPORTATION IS AVAILABLE

Join Chris Lopez and learn about small scale water harvesting/ watershed
restoration. Access to clean, reliable drinking water and wastewater

systems is critical to the health, well-being, and economic security of
individuals and families. However, an estimated 48% of households on

Native American reservations do not have access to clean drinking water or
adequate sanitation. 

 RSVP Contact:
Ancita Juarez-

Family Programming Specialist
amjuarez@sstanf.org or (916) 760-1668

February 6, 2025
5pm-7pm

 P A R T I C I P A N T S  O N L Y  |  T R A N S P O R T A T I O N  A V A I L A B L E

Water is Life
S H I N G L E  S P R I N G S  T R I B A L  T A N F  P R O G R A M

Open Beading
Shingle Springs Tribal TANF Program

To RSVP  Contact:
Nikki Grant Perez
Family Programming Specialist
nperez@sstanf.org
(530)409-0541

Join us to finish any projects you are working
on. There will be a raffle for attendees for a

chance to win beading related prizes. Beading
boxes will be provided with mini projects. We

will discuss ways to market your work and
entrepreneurial advice. 

 P A R T I C I P A N T S  O N L Y  |  T R A N S P O R T A T I O N  A V A I L A B L E

7
FEBF R I 1 0 : 3 0 A M -

2 : 0 0 P M
S A C R A M E N T O  S I T E

2 0 3 3  H O W E  A V E ,
S A C R A M E N T O ,  C A

Basic Computer
Skills Workshop 

Participants will learn about the different parts of
a computer and what each part does, as well as

the various types of computers. 

Workshop 1 of 6 that will be
conducted in 2025

Transportation Available Upon Request

For more information, please contact 
Cayce Borges, Employment Coordinator, at (916)760-1663 or

via email at CBORGES@SSTANF.ORG

Location:
Sacramento TANF Office

2033 Howe Ave. Suite 200
Sacramento, CA 95825

Date and Time:
Tuesday, 2/11/2025

10am-1pm

Virtual option also available:
Zoom Meeting ID: 871 0024 7343

Password: TANF2024



S H I N G L E  S P R I N G S  T R I B A L  T A N F  P R O G R A M

Join Al Striplin
 Flute Lessons 

I am of Amah Mutsun Ohlone (California Native) and Aztec heritage and hold an
M.A. in Counseling. As a university counselor and Native Studies professor, I

devoted my career to advocating for diverse communities and Native American
families. I am also an artist, musician, author, and illustrator. It is said that

music, art, and other creative expressions come directly through the veil from
spirit, and seek form through our individual, unique efforts.  I keep these

thoughts in mind as I play and teach Native American flute. 

5 -10 years old
February 18, 2025
Sacramento Site

4pm-6pm

*Parent must be present*

10-18 years old
February 19, 2025
Sacramento Site

4pm-6pm

 RSVP Contact:
Ancita Juarez-

Family Programming Specialist
amjuarez@sstanf.org or (916) 760-1668

Class sizes are limited to 5 participants per class
Youth must attend 2 consecutive age appropriate classes in  order to

receive flute and lessons. 

 P A R T I C I P A N T S  O N L Y  |  T R A N S P O R T A T I O N  A V A I L A B L E

DAUGHTERS
OF TRADITION

For a young girl to grow into a healthy woman, there are 8 feelings that must be
developed. The fourth of these feelings are developed between the ages of 7-12. After

talking to the Elders and Clan Mothers, the program was developed. A prevention
education program that provides adults who work with teens and pre-teens the

traditional knowledge to prepare daughters to become healthy teens.

Shingle Springs Tribal TANF

TANF Participants Only I Transportation Available

Contact....
PAULINE GHOST

PPEREZ@SSTANF.ORG OR
CALL 916-798-9433

February 21, 2025  5:00-7:00pm,
Sacramento

SHINGLE SPRINGS TRIBAL TANF 

Young Mens
Drum Group

Friday February 21,

5:00pm-7:00pm


